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はじめに

daVinci とは ?

　daVinci はデジタルオーディオシステム Audia、Nexia 用のカスタムコンピューターコントロール画面を作成し使用するため

のソフトウェアです。グラフィックコントロールインターフェースの持つ機能と表現力でユーザーのニーズに合わせた作成が可

能です。個々またはグループ化された制御パーツを配置し、システムが持つ特定の機能をアサインしたり、コンポーネント

オブジェクトをシステム設計ファイルから daVinci に直接コピーしてすべてアサイン済みの制御画面を作ることもできます。制

御パーツ、背景、ラベルをグラフィカルに処理するために描画ツールが用意されています。複数ページ間を簡単に移動でき

る機能を盛り込むこともできます。作成した制御ファイルをシステムにダウンロードすると daVinci ソフトウェアをインストール

したネットワーク上にある複数台のパソコンからアクセスすることができるようになります。このソフトウェアではシステム設計

そのものを変更することはできず、システムへのアクセスもパスワードでプロテクトすることができます。システムの制御には

daVinci ソフトウェア、壁面パネル、あるいは他社製の RS-232 対応機器を組み合わせて同時に使用することができます。

構造的、技術的な仕様

　このコントロールソフトウェアプログラムはデジタルオーディオシステム Audia や Nexia と併用するためのカスタムコンピュー

ター制御画面を作成し、使用するためのものです。このソフトウェアは、ユーザーのニーズに合わせたグラフィックコントロー

ルインターフェースを作成するための機能や表現に対応します。個々の、またはグループ化された制御機能を配置してシス

テム中にある特定の機能を割り当てることができます。または Audia や Nexia のシステム設計ファイルからコンポーネントオ

ブジェクトを直接コピーして、完全にアサイン済みの制御画面を作ることもできます。制御パーツ、背景、ラベルに多彩な画

像処理を行うための描画ツールもあります。複数ページ間を簡単に移動する機能を持たせることもできます。作成したカスタ

ムの制御ファイルを Audia や Nexia のシステムにダウンロードすれば、このソフトウェアをインストールしてネットワークに接続

された複数台のパソコンからアクセスすることができます。このコントロールソフトウェアからシステム設計そのものを変更する

ことはできず、また制御のためのアクセスもパスワードでプロテクトすることができます。システムの制御はこのコントロール

ソフトウェア、壁面パネル、他社製の RS-232 対応機器を組み合わせて同時に行うことが可能です。

　最低推奨システムは Windows XP または Vista、Pentium 4 相当 1.5GHz、RAM256MB、画面解像度 1280 × 1024 です。

　このコントロールソフトウェアは daVinci です。
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Property Sheet　プロパティシート　

　プロパティシートはサーフェス上で選択したオブジェクトの属性をカスタマイズするときなどに使います。

Surface　サーフェス

　サーフェスはカスタムの制御画面を作るためにオブジェクトを配置するスペースです。単体の制御機能はコント

ロールバーから配置することができます。グループ化した制御機能で一般的な多機能システムを表すものはオブ

ジェクトバーから配置することもできます。制御機能はプロパティシート ( �� � ����������������次項)��  ��������������を使って、カスタマイズしたりシス

テム設計中にある特定のコンポーネントが持つ機能にアサインすることができます。��������������またカスタマイズしたりよく使

うコントロールを、将来使用するときのためにコントロールライブラリにコピーしておくことができます。さらに���システ

ム設計ファイルからコンポーネントオブジェクトを直接このサーフェスにコピーしてくることもでき、この場合は適切

にグループ化され機能もアサインされて表示されることになります。

ソフトウェアのツール

Layout>Properties...

オブジェクトバー

→ P16

コントロールバー

→ P16

コントロールライブラリ

→ P5

オブジェクトの位置、

サイズ、形状、向き、色、

ラベルなどを変更する

ときに使います。

制御機能をシステム設計ファイル中のコ

ンポーネントにアサインするために使いま

す。インスタンス ID( ���������またはインスタンス

ID タグ )��������� ������、DSP ブロックの種類、属性、

入力 / 出力といった情報はシステム設計

ファイルから入手します。オブジェクト

バーから配置したグループ化された制御

機能にはインスタンス ID( �������またはインスタ

ンス ID タグ )������������   を 1 つ付ければかまいませ

んが、この場合はグループ全体でアサイ

ンするためあらかじめ 1By1 を無効にして

おきます。またシステム設計ファイルから

コンポーネントを直接コピーして、グルー

プ化もアサインもできているものを表示

させることができます。この場合は Dis-

play Attributes タブでその制御機能を

さらにカスタマイズすることができます。

　 ������     こ の ����   タ ブ に は User Access Lev-

el( ユーザーアクセスレベル ) という欄が

あります。これはユーザーアカウントによっ

ては特定の制御機能にアクセスできない

ようにするものです。また同じ種類の制御

機能を複数組み合わせて動作させるため

の Gang Group もあります。

　Data Attributes タブは制御に使うオブジェクトだけに表示されます。Display Attributes は制御機能のない

テキストボックスやフレーム、サーフェスなども含めて全てのオブジェクトで表示されます。

　表示属性の中でも位置、サイズ、形状、色、ラベルなどはサーフェス自体の中でもカスタマイズすることがで
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Main Menu　メインメニュー

File　ファイルメニュー

New( 新規作成 )…新しいファイルを作成します。

Open( 開く) …保存されているファイルを表示します。

Close( 閉じる )…使っているファイルを閉じて変更を保存します。

Save( 上書き保存 )…使っているファイルを保存します。���������デフォルトフォルダ

は My Documents\Biamp|daVinci\Data Files です。

Save As( 名前を付けて保存 )…ディレクトリを選択してファイル名を付け、

使用中のファイルを保存します。

NOTE　拡張子は .dva…Audia 用ファイル、 .dvn…Nexia 用ファイルです。

Network( ネットワーク )…この機能に関するサブメニューが開きます。

Print( 印刷 )…プリンターを設定したりサーフェスを印刷するためのダイアロ

グボックスが開きます。

Print Preview( ������� �������������������印刷プレビュー �������������������)…�����������������印刷設定に基づいて想定される印刷結

果を表示します。

Print Setup( 印刷設定 )…プリンターを設定するためのダイアログボックス

が開きます。

Exit( 終了 )…daVinci を閉じます。このときファイル保存のプロンプトが表示されます。ファイルを開いたまま終

了すると、次に daVinci を起動したときにそのファイルが開きます。

　簡単にアクセスできるよう最近保存したファイルがこのメニューの下部にリストで表示されます。このメニューに

は対応するツールバー上のアイコンとキーボードのショートカットが表示され�����てい���ます。

Control Library　コントロールライブラリ

　コントロールライブラリはカスタマイズしたりよく使う制御機能を保存するのに便利な場

所です。サーフェス上でオブジェクトを選択してコントロールライブラリにペーストします

(Alt キーを押しながらドラッグするか右クリックして Copy/Paste をお使いください )。その

制御機能のアイコンが選択したカテゴリー ( デフォルトでは daVinci Controls) の中に表

示されます。アイコンの名称を変更する場合は該当するアイコンを選択し、次にテキストを

クリックしてください。新しいカテゴリーファイル ( 拡張子 .apl) を作るときはコントロールラ

イブラリ上で右クリックしてメニューを表示させ Ctrl Lib をクリックしてください。

　カテゴリー�����������������������������������を����������������������������������選択��������������������������������す�������������������������������ると使用可能なコンポーネントがカテゴリーヘッダーの下に表示され

ます。全てのコンポーネントが表示きれないときは縦のスクロールバーが表示されます。

ここから制御機能を配置するときはアイコンをサーフェスにドラッグしてください。

　���������������タイトル右のメニューアイコン  でコントロールライブラリをドッカブルにすることがで

きるので、非表示にしたり自動非表示 ( 密着時 ) にすることができます。コントロールライ

ブラリを開いたままにしておく ( 自動非表示不可に設定する ) と、画鋲が表示されます。コ

ントロールライブラリを閉じるには右上の×をクリックしてください。コントロールライブラ

リは��������  �� � �メイン�����  �� � �メニュー ( �� � �次項)�  の Control Library メニューでカテゴリーを選択して開くことがで

きます。または View メニューの Toolbars でアクセスすることもできます。コントロールラ

イブラリが開いているとき、設計中はサーフェスの左側に表示されています。実際に操作

しているときやテストモードでは使用できません。

きます。こうした項目はオブジェクトをドラッグするだけで変更できるもの、あるいはレイアウトバーやフォーマット

バーから選択して変更するものもあります。���������������タイトル右のメニューアイコン  でプロパティシートをドッカブルウイ

ンドウにすることができるので、非表示にしたり自動非表示 ( 密着時 ) にすることができます。プロパティシートを

開いたままにしておく ( 自動非表示不可に設定する ) と画鋲が表示されます。

　プロパティシートを閉じるには右上の角にある×をクリックしてください。プロパティシートを再度開くときはレイ

アウトバーから選択します。実際に操作しているときやテストモードでは使用できません。

Control Library メニュー

→ P8

View メニューの Toolbars

→ P6

テストモード

→ P26

レイアウトバー

→ P20

フォーマットバー

→ P20
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Network メニュー

Connect To Network( ネットワークに接続する )…通信を確立する機能

で、ネットワーク上の Audia、Nexia の全デバイスがリスト表示されます。

Disconnect From Network( ネットワークから切り離す )…ネットワーク

上全デバイスとの通信を切断します。

Connect To System( システムに接続する )…ネットワーク中で選択した

Audia や Nexia との通信を確立します。

Disconnect From System( システムから切り離す )…ネットワークの中

で選択したシステムとの通信を切断します。

Synchronize State Data( データ状態の同期 )…制御データを手動でアップデートしてシステムデバイスに適

合させる機能です。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Edit　エディットメニュー

Undo( アンドゥ )…最後の操作を取り消します。

Redo( リドゥ )…最前のアンドゥ (Undo) を取り消します。

Cut( 切り取り )…選択したオブジェクトをクリップボードに移動します。

Copy( コピー )…クリップボードに選択したオブジェクトの複製を置きます。

Paste( 貼り付け )…クリップボード上のオブジェクトをサーフェスに配置しま

す。

Duplicate( 複製 )…選択したオブジェクトの複製をサーフェスとクリップボー

ドの両方に置きます。このコマンドは一度に選択された 1 つのオブジェクト

にしか機能しません。

Select All( 全てを選択 )…この機能に関するサブメニューが開きます。

Delete( 消去 )…サーフェス上で選択したオブジェクトをクリップボードにコ

ピーを置かずに消去します。

　このメニューには対応するツールバー上のアイコンとキーボードのショート

カットが表示され�����てい���ます。

View　ビューメニュー

Toolbars( ツールバー )…この機能に関するサブメニューが開きます。

Status Bar( ステータスバー )…ステータスバーを表示します。

Ruler Bars( ルーラーバー )…サーフェスにルーラーを表示します。

Zoom( ズーム )…この機能に関するサブメニューが開きます。

Full Screen Mode( 全画面モード )/Full Window Mode( �������フルウインドウ

モード )���������������������…アドミニストレータが全画面表示を選択するための機能です。

　このメニューには対応するツールバー上のアイコンとキーボードのショートカットが表示され�����てい���ます。

Toolbars メニュー

　��������この������メニューにはスタンダードツールバー (Standard Toolbar)、オブジェクト

バー (Object Bar)、コントロールバー (Control Bar)、レイアウトバー (Layout 

Bar)、フォーマットバー (Format Bar)、ネットワークバー (Network Bar)、コント

ロールライブラリ (Control Library) を表示したり隠したりする機能があります。

Customize( カスタマイズ )…ダイアログボックスが開きツールバーをカスタマ

イズすることができます。

　このメニューには対応するキーボードのショートカットが表示され�����てい���ます。

ステータスバー

→ P21

ス タ ン ダ ー ド
ツールバー

→ P16

オブジェクトバー

→ P16

コントロールバー

→ P16

レイアウトバー

→ P20

フォーマットバー

→ P20

ネットワークバー

→ P20

コントロールライブラリ

→ P5

File>Network

View>Toolbars



Help File Ver 2.2�　No. 02027-100903  �

Customize ダイアログボックス

　この機能は既存のツールバーとメイン����メニューを編集して新しいツールバーを作るためのものです。編集した

ツールバーには名前を付けることができます。

Command タブ

　メインメニューの内容がカテゴリー

別に表示されます。新しいツールバー

を作成するときはその内容をこの一覧

からドラッグします。

Toolbars タブ

　チェックマークを付けたツールバーが表示されます。
ツールバーをデフォルトに戻します。

ツールバーを全てデフォルトに戻します。

新しいツールバーを作成します。

ツールバーの名前を変えます。

選択したツールバーを削除します。ただしデ

フォルトで用意されているツールバーは削除

できません。

チェックを付けるとツールバーのアイコンに

機能を説明するテキストが表示されます。

Menu タブ
変更したメニュー表示を適用する範囲を決め

ます。Audia 用サーフェスのみ、Nexia 用サー

フェスのみ、デフォルトメニューに適用の 3

つから選択できます。

Audia 用サーフェスのみ、Nexia 用サーフェス

のみ、デフォルトメニューのいずれかに適用

したメニューの設定をデフォルトに戻します。

メニューを表示するときのアニメーションを

選択します。

ツール��バー

→ P16

メインメニュー

→ P5
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Zoom メニュー

Zoom In( 拡大 )…サーフェスを 25% ステップで拡大表示します。

Zoom Out( 縮小 )…サーフェスを 25% ステップで縮小表示します。

Zoon 1:1( 原寸表示 )…サーフェスを 100% の大きさで表示します。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Control Library　コントロールライブラリメニュー

　Control Library メニューにはコントロールライブラリのカテゴリーがリストで

表示されます。このメニューからカテゴリーを選択すると対応するコントロー

ルライブラリが自動的に表示されます。

　このメニューには対応するキーボードのショートカットが表示され�����てい���ます。

Tools　ツールメニュー

Passwords( パスワード )…この機能に関するサブメニューが開きます。

Options( オプション )…ソフトウェアの動作を調整する Options ダイアログ

ボックスが開きます。このダイアログボックスには General ��タブ、Dis-

play ��タブ、Auto Connect ��タブ、Network ��タブがあります。

Password メニュー

Login( ログイン )/Logout( ログアウト )…システムのネットワークに接続さ

れているパソコンで daVinci のサーフェスに直接アクセスするためのも

のです。ログインにはユーザー名とパスワードが必要です。あらかじめ

User Acounts( ユーザーアカウント ) ダイアログボックスで設定してく

ださい。

Edit User Acounts(ユーザーアカウントの編集)…制御機能に対するユー

ザーのアクセス権を制限する User Accounts ダイアログボックスが

開きます。

Options タブ

チェックを付けるとポインターがツールバー

アイコンに移動したときそのアイコンのヒント

が表示されます。

アイコンのヒントが表示されるときショート

カットキーも表示されます。

メニュー表示のとき最近使ったコマンドだけ

を表示させる機能です。

最近使ったコマンドを優先的に表示させてい

るとき、しばらく経つと自動的に全コマンドが

表示される機能です。

それまでに使用したメニューに関する仕様履

歴を消去します。またコマンド、メニューやツー

ルバーの表示もデフォルトに戻ります。

View>Zoom

Tools>Passwords

コントロールライブラリ

→ P5

Options
ダイアログボックス

→ P9
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User Acounts ダイアログボックス

　各ユーザーがアクセスできる制御機能を制限するものです。パスワードプロテクトに加え User( ユーザー名 ) に

はアクセスレベル (Access Level) がアサインされます。制御機能は、プロパティシートを使って 1 から 5 までの

アクセスレベルを設定することができます。

Edit User Acounts ダイアログボックス

　ユーザーアカウントを作ったり編集するためのものです。

Options ダイアログ
ボックス

→ P9

コントロールページ

→ P19

プロパティシート

→ P4

アカウントを編集する Edit User Accounts ダイ

アログボックス ( 下記 ) が開きます。

選択したアカウントを削除します。

オフラインのときは「OK」になっています。アカ

ウントは daVinci の一部として保存されることにな

ります。

オンラインのとき「Send」になっています。アカ

ウントをシステムに保存します。

ユーザーアカウントを設定するときに必要です。

このユーザーが最初にアクセスするコントロール

ページを定義します。

必ずアサインしてください。アクセスレベルはその

ユーザーがアクセスできる制御機能を定義するも

のです。コントロールオブジェクトにもアクセスレ

ベルがアサインされており、プロパティシートで

設定します。アクセスレベルは 5 段階です。レベ

ル 1 はあらゆる制御機能にアクセスでき、レベル

2 はレベル 1 だけで制御できる以外の制御機能す

べてにアクセスでき、レベル 3 はレベル 1 または

2 だけで制御できる以外の制御機能すべてにアク

セスできる、などとなっています。
　そのユーザーでは制御不可能な機能は表示されま

すが無効になります。制御できない機能を表示したく

ない場合は Options ダイアログボックスの General

タブで設定します。

Options ダイアログボックス

General タブ
データ、コントロールライブラリ、イメージそれ

ぞれを保存しておくディレクトリを選択します。

Browse ボタンでディレクトリを参照可能です。

連続して同じオブジェクトを配置する機能です。

アクセスできない制御機能をグレー表示にするの

ではなく表示させない機能です。

オブジェクトツールバーから配置したグループ化

されたオブジェクトには背景を含めません。

選択した制御機能から焦点になる長方形を削除す

るタッチパネルモードに切り替えます。

表示をプリセット番号にするか単純に Recall にす

るか変更するものです。

チェックを付けておくと自動的にバックアップを保

存します。右側のウインドウでバックアップを保存

する間隔を設定してください。

この項にチェックが入っていないとき、新しいサー

フェスを開いてもグリッドは表示されません。

オブジェクト�����ツール��バー

→ P16
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Display タブ

Window メニュー

→ P15表示形式を選択します。この選択は daVinci 上のさま

ざまな要素に反映されます。

チェックを付けると複数のファイルを開いたときにタ

ブが表示されます。下の 3 つのチェックボックスはそ

れぞれタブの形状、色、位置を変更するものです。

Enable MDI Tabs にチェックが付いていない場合は

Window メニューでファイルを切り替えてください。

Auto detect host display resolution にチェックを

付けると自動的に設定されますが、幅 (Width) と高さ

(Height) を手動で指定することもできます。このとき

設計モード中サーフェスに表示される境界線の色を選

択することもできます。

Auto Connect ��タブ 特定のパソコンを daVinci コントロールシステムに自

動的に接続します。

特定のショートカットコマンドを使ったときだけ自動接続

するように設定します。

daVinci を起動すると自動的に接続します。

自動接続の上書きを保護するパスワードを入力します。

ID 番号、全デバイスの IP アドレスを入力します。

特定のユーザーを自動的にログインさせます。ID とパ

スワードを入力してください。

User Setings( 全ユーザーに作用 ) でサーフェスの

設定を使用するか、特定のユーザーに作用する Full 

Screen( 全画面 )/Full Window( 全ウインドウ ) 表示に

するかを切り替えます。

User Surface settings( 全ユーザーに作用 ) でサー

フェスの設定を使用するか、特定のユーザーに作用す

る Use setting below( 下の設定を使用 ) を使います。

ユーザーが接続を切断した

ときの反応を選択します。

接続に失敗したときの反応を選択します。下の欄にこ

のとき表示するメッセージを入力してください。

初期化に時間がかかる無線ネットワークに対応するた

め、自動接続がタイムアウトするまでに 10 秒までのディ

レイを付加することができます。
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Netowork タブ
ネットワークへの接続法を選択します。

メッセージを基本にしたデフォルトの方法でネット

ワーク上のデバイスを探します。

機器の IP アドレスを特定して接続します。通信がベー

スでファイヤーウォールを避けたり、カスタムデバイ

スリストを作ったり、複数のサブネットワークを超えた

り、モデムを使って離れた場所からアクセスすること

ができます。

TCP のデバイスリストが開きます。新しいデバイ

スを追加するときは Add をクリックして Subnet 

Address の下をダブルクリックし、IP アドレスの最

初から3つの数字を入力し、次にEdit Nodesをクリッ

クして IP アドレス最後の数字を選びます。

daVinci が起動しているパソコンに複数のネットワーク

インターフェースカード (NIC) が入っているとき特定

のものを選択してください。

Layout　レイアウトメニュー

Pack Objects( オブジェクトをパックする )、Align Objects( オブジェクトを整

列する )、Space Evenly( 等間隔にする )、Center In View( 中央に表示 )、

Make Same Size( サイズの統一 )、Grouping( グループ化する )、Order( 並

び順 ) にはそれぞれサブメニューがあります。各サブメニューは次ページ以降で

ご紹介していますのでご参照ください。

Object( オブジェクト )…オブジェクトシート (Object Sheet) が開きます。

Layers( レイヤー )…レイヤーシート (Layer Sheet) が開きます。

Properties( プロパティ )…プロパティシート (Property Sheet) が開きます。

Edit Gang Groups( ギャンググループの編集 )…Gang Group ダイアログボッ

クスが開きます。

Edit Hotspots( ホットスポットの編集 )…この機能に関するサブメニューが開

きます。

Control Pages( コントロールページ )…この機能に関するサブメニューが開き

ます。

Grid Settings( グリッドの設定 )…Grid Settings ダイアログボックスが開きま

す。

Test Mode( テストモード )…編集ができなくなりオフラインで制御を試すテス

トモードになります。

　このメニューには対応するツールバー上のアイコンとキーボードのショートカット

が表示され�����てい���ます。

Pack Object メニュー

Left( 左 )…選択した複数のオブジェクトが左を基準に密着���������して配置�����されます。

Right( 右 )…選択した複数のオブジェクトが右を基準に密着���������して配置�����されます。

※ Left、Right の場合、選択されたオブジェクトの中でいちばん上にあるものが

基準点になります。

Top( 上 )…選択した複数のオブジェクトが上を基準に密着���������して配置�����されます。

Bottom( 下 )…選択した複数のオブジェクトが下を基準に密着���������して配置�����されます。

※ Top、Bottom の場合、選択されたオブジェクトの中でいちばん左にあるものが

基準点になります。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Layout>Pack Object

オブジェクトシート

→ P13

レイヤーシート

→ P13

プロパティシート

→ P4

Gang Group
ダイアログボックス

→ P13

Grid Settihgs
ダイアログボックス

→ P14

ネットワークがタイムアウトするま

での時間を設定してください。
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Align Objects メニュー

Left( 左 )…選択した複数のオブジェクトが左を基準に整列します。

Right( 右 )…選択した複数のオブジェクトが右を基準に整列します。

Top( 上 )…選択した複数のオブジェクトが上を基準に整列します。

Bottom( 下 )…選択した複数のオブジェクトが下を基準に整列します。

Vert.Center( 垂直方向で中揃え )…選択した複数のオブジェクトが垂直方向で

中揃えになります。

Horz.Center( 水平方向で中揃え )…選択した複数のオブジェクトが水平方向で

中揃えになります。

※整列の基準は最初に選択された ( ハンドルが緑色の ) オブジェクトです。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Space Evenly メニュー

Across( 横 )…選択した複数のオブジェクトを水平方向で等間隔にします。

Down( 縦 )…選択した複数のオブジェクトを垂直方向に等間隔にします。

※���������������������  ��������������選択した中で���������������  ��������������最も離れ�����������  ��������������た ���������� ��������������2 つのオブジェクトを基準に等間隔で配置されます。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Center In View メニュー

Both( 両方 )…選択したオブジェクトをサーフェスの表示範囲内で水平方向、垂

直方向ともに中央に配置します。

Vertical( 垂直方向 )…選択したオブジェクトをサーフェスの表示範囲内で垂直方

向の中央に配置します。

Horizontal( 水平方向 )…選択したオブジェクトをサーフェスの表示範囲内で水

平方向の中央に配置します。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Make Same Size メニュー

Both( 両方 )…選択した複数のオブジェクトを同じ幅、高さにします。

Width( 幅 )…選択した複数のオブジェクトを同じ幅にします。

Height( 高さ )…選択した複数のオブジェクトを同じ高さにします。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Grouping メニュー

Group( グループ化 )…選択した複数のオブジェクトを 1 つにします。

Ungroup( グループ解除 )…グループ化されたオブジェクトを分割して 1 つ

ずつのオブジェクトにします。

Regroup( 再グループ化 )…グループ解除した中で直近のものを再度グルー

プ化する機能です。

　このメニューには対応するツールバー上のアイコンとキーボードのショートカッ

トが表示され�����てい���ます。

Order メニュー

Bring To Front( 最前面に配置 )…選択したオブジェクトをすべてのオブジェ

クトの中で最も前面に配置します。

Send To back( 最背面に配置 )…選択したオブジェクトをオブジェクトの中

で最も背面に配置します。

Forward( 前面へ送る )…選択したオブジェクトを他のオブジェクトに比べて

前面に送ります。

Backward( 背面へ送る )…選択したオブジェクトを他のオブジェクトに比べて背面に送ります。

　このメニューには対応するツールバー上のアイコンとキーボードのショートカットが表示され�����てい���ます。

Layout>Align Object

Layout>Space Evenly

Layout>Center In View

Layout>Make Same Size

Layout>Order

Layout>Grouping
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Gang Groups ダイアログボックス

Object Sheet　オブジェクトシート

　オブジェクトシートはサーフェスに表示��中のコントロール

ページに配置された全オブジェクトのリストです。このリス

トにはオブジェクトコード����������������  ごとに�������������  オブジェクトの種類や ( それ

ぞれの名称 )、タブの順番が表示されます。オブジェクト

シートが閉じているときはキーボードの Tab キーを押すと

順番にオブジェクトを選択できます。このときのタブ順はオ

ブジェクトシートで変更することができます。リスト中で変

更したいオブジェクトを上あるいは下にドラッグするか、矢

印の上下キーを押してください。またこのリストから直接オ

ブジェクトを選択�����可能です�。

Layers Sheet　レイヤーシート

　レイヤーシートはレイヤーのプロパティを編集可能な表形式で表示します。レイヤーはサーフェスを複数のパー

ツに分割するためのものです。オブジェクトの種類、システムの部分ごとなどさまざまな基準で作ることができます。

コントロールページ

→ P19

常 に 残 る レ イ ヤ ー で す。 他 の レ イ ヤ ー は Add( 追 加 ) や

Delete( 削除 ) コマンドが使えます。レイヤーをこのリストから直

接選択することができます。

Up/Down ボタンはこのリストの中だけでレイヤーの表示順番を

決めるものです。レイヤーは重なっているものではないためタ

ブ順や重なった場合の表示には影響しません。

選択したレイヤーにあるすべてのオブジェクトを選択します。

追加したレイヤーに付ける名前を入力します。

サーフェスにそのレイヤーを表示するかどうかを切り替えるものです。

NOTE　隠れている ( サーフェス上に表示されていない ) レイ

ヤーにあるオブジェクトは選択することができません。

そのレイヤーを変更あるいは選択することができなくなります。

Lock と View はリスト上の対応するアイコンをダブ

ルクリックしても切り替えることができます。

　このダイアログボックスは同じ種類の複数の制御機能を

組み合わせて動作させるためのものです。ギャンググルー

プはまずこのリストで作成しておかなければなりません。そ

の次に同じ種類の複数の制御機能をプロパティシートでグ

ループにします。

NOTE　テストモードの場合でも、ギャングするオ

ブジェクトにはインスタンス ID、DSP ブロックの種

類、属性、入力 / 出力をアサインしていない場合は

適切に動作しません。

　ギャンググループは Add( 追加 ) や Delete( 削除 ) で作成

したり消去することができます。

　新しいギャンググループを追加するとトグルボタンが表

示され、ギャンググループにアサインしているすべての制御

機能をギャングするかしないかを選択できるようになります。

必要のないギャングボタンは削除してもかまいません。トグ

ルボタンを作ってギャングの���������������コントロール���������にアサインすること

もできます。
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　プロパティシートからギャンググループにアサインした制御機能はすべてをマスターに設定することもできます。

ギャンググループとマスターの動作は制御の種類によって変化します。

トグルボタンをギャングした場合…マスターになっている制御機能のステータスを切り替える (ON/OFF する )

とそのギャングにある他のマスターは元の状態に関係なく切り替わります。マスターになっていない制御機能

はマスターのように同じ状態 (ON/OFF) になります。

フェーダー、エディット、エディットスピンをギャングした場合…マスターの設定を変更するとそのギャングに

属する他の制御機能も追従して変化するため、お互いの量的な関係は維持されます。マスターの制御範囲

が制限されている����������������������������������������ため��������������������������������������、他の制御機能がその範囲外に������������������������なってしまう������������������場合があります。マスターになっていな

いものを変更してもギャングしている他の制御機能に影響はありません。

グラフをギャングした場合…グラフをマスターとしてアサインすることはできません。ギャングされたグラフの制

御機能は実際の操作通りにフィルターごとに動作します。パラメトリックイコライザーやオールパスフィルター

はそれぞれのフィルターバンド数が違っていてもギャングすることができます。この場合は共通のフィルター

数 ( 初期の数字順で最初からの数 ) だけがギャングされることになります。

ＮＯＴＥ　制御機能のギャングをプリセットリコールの結果�����������������������として��������������������変更するとギャングとしては動作しません。

Edit Hotspot メニュー

Edit Points…選択したホットスポットの接続線を表示するもので、形状を編集

するためのものです。ホットスポットに編集ポイントを追加することもできます。

Rotate…選択したホットスポットのハンドルを表示するもので、手動で回転する

ときに使います。選択したホットスポットの回転はプロパティシートから設定す

ることもできます。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Control Pages メニュー

Edit Control Pages…Page Selection ダイアログボックスが開きます。

Previous Control Page…�������������������  表示しているコントロールページの 1 つ�前

の��������もの������を開きます。

Next Control Page…������������������  ����表示しているコントロールページの 1 つ次���の��もの

を開きます。

　このメニューには対応するツールバー上のアイコンとキーボードのショートカットが表示され�����てい���ます。

Page Selection ダイアログボックス

　このダイアログボックスはコントロールページを編集可能な表形式で表示します。

コントロールページはサーフェスを複数の部分に分割するために使うものです。コン

トロールページはオブジェクトの種類、システムの要素などさまざまな基準で作る

ことができます。

　デフォルトの Page 1 は名前を変更することができますが削除することはできませ

ん。他のコントロールページは Add( 追加 ) と Delete( 削除 ) で作成したり消去す

ることができます。この表から直接コントロールページを選択することができます。

Up と Down はそのコントロールページのリストでの並び順を変更する機能で、コ

ントロールページの選択順にも影響します。コントロールページに名前を付けるとき

は Name に入力してください。

Grid Sttings ダイアログボックス

　このダイアログボックスはサーフェスに表示されるグリッドをカスタマイズするものです。

Layout>Edit Hotspots

Layout>Control Pages

プロパティシート

→ P4

チェックが付いているときグリッドが表示

されます。

チェックが付いているときオブジェクトの

左上の角がグリッドマークに吸着します。

緑の点線で表示されるガ

イドライン ( 初期設定では

サーフェスの端付近にあり

ます ) をピクセル単位で移

コントロールページ

→ P19
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選択したファイルを閉じます。

Help　ヘルプメニュー

Help Topics…daVinci のヘルプファイルを開きます。

About daVinci と Show Splash Window…ソフトウェアのバージョン情

報を表示するウインドウが開きます。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

動します。

Window　ウインドウメニュー

Close…アクティブになっているサーフェス (daVinci ファイル ) を閉じます。

Close All…そのとき開いているサーフェス (daVinci ファイル ) をすべて閉じます。

Windows…開いている複数のファイルで作業を行うためのダイアログボックスが開

きます。

　そのとき開いているファイルがこのメニューの下部に表示されていて簡単にアクセスす

ることができます。

　Window メニューは Option ダイアログボックスの Display タブにある MDI が無効になっているときレイアウトが

変わります。

　このメニューには対応するツールバー上のアイコンが表示され�����てい���ます。

Windows ダイアログボックス

選択したファイルをアクティブにします。

選択したファイルを保存します。

Options ダイアログ
ボックス

→ P9
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ツールバー

Standard Toolbar　スタンダードツールバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　  New( 新規作成 )、  Open( 開く) 、  Save( 保存 )、  Print( 印刷 ) は File メニューにあるものと同

じ機能です。

　  Cut( 切り取り )、  Copy( コピー )、  Paste( 貼り付け )、  Undo( アンドゥ )、  Redo( リドゥ ) は

Edit メニューにあるものと同じ機能です。

　Help 機能は Help メニューにあるものと同じ機能です。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

Object Bar　オブジェクトバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　オブジェクトバーは制御機能を集めたもので、システム設計用のコンポーネントをサーフェスに配置するために

使います。グループ化された制御機能は同じカテゴリーに分類されていて Audia ソフトウェアや Nexia ソフトウェア

と共通です。

　オブジェクトバーには  Input( 入力 )/Output( 出力 )、  Mixer( ミキサー )、  Equalizer( イコライザー )、

 Filters( フィルター )、  Crossovers( クロスオーバー )、  Dynamics( ダイナミクス )、  Rout-

ers( ルーター )、  Delays( ディレイ )、  Controls( コントロール )、  Meters( メーター )、  Genera-

tors( ジェネレーター ) があります。

　各カテゴリーはアイコンで表示されていて右側にある▼をクリックするとドロップダウンメニューが開きます。オブ

ジェクトを配置するにはまず対応するカテゴリーを選択し、ドロップダウンメニューから配置したいコンポーネントを

選択します。コンポーネントを選択してからサーフェス上でクリックすればその位置にオブジェクトが配置されます。

制御機能によってはポップアップメニューが開いてオプションを選択することができるので、制御するコンポーネン

トに合わせて設定してください。次に制御するコンポーネントに合わせて、プロパティシートでインスタンス ID を設

定します。

NOTE　コンポーネントはコンパイル済みの Audia や Nexia の設計ファイルからコピーすることもできます。

コピーしたオブジェクトを daVinci のサーフェスに配置る場合はコンポーネントのオプションやインスタンス

ID を改めて設定する必要はありません。

　オブジェクトバーにはまた選択カーソルやテキストカーソルが用意されています。選択カーソル ( デフォルト ) は

オブジェクトを選択、配置、操作するためのものです。テキストカーソルはサーフェス上に静的なテキストオブジェ

クトを配置するためのものです。テキストはプロパティシートから操作できます。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

Contorl Bar　コントロールバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　コントロールバーにはサーフェスに配置できる制御機能が集まっています。制御機能は種類によってカテゴリー

に分けられています。

　コントロールバーには  Picture( 画像 )、  Frame( フレーム )、  Edit( エディット )、  Edit-Spin( エ

ディットスピン )、  Button( ボタン )、  Toggle Button( トグルボタン )、  Fader( フェーダー )、  Me-

File メニュー

→ P5

Edit メニュー

→ P6

Help メニュー

→ P15

View メニュー

→ P6

プロパティシート

→ P4
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 Frame�����　����フレーム

　制御に関係のない画像で、制御機能や制御画面を分割するためのフレームやラベルと

して使うものです。サーフェス上������で操作したりプロパティシートで編集することができます。

 Edit������　�����エディット

エディットコントロールを新規作成します。エディットコントロールは数値の表示を制御するもので、キーボード

から入力して調整することができます。

ter( メーター )、  LED( インジケーター )、  Grid( グリッド )、  TI Dialer(TI ����� ��ダイヤラー )、  Graph( グラフ )、

 Paging( コントロールページ )、  Hotspot( ホットスポット ) があります。

　各制御機能はアイコンで表示されています。オブジェクトを配置するにはまず対応するアイコンをクリックし、そ

れからサーフェス上の配置したい位置をクリックするだけです。制御機能によってはポップアップメニューが開い

て制御するコンポーネントに対応するようオプション設定が必要なものもあります。プロパティシートの Data Attri-

butes( データ属性 ) は制御されるコンポーネントに合わせてアサインしてください。

NOTE　コンポーネントはコンパイル済みの Audia や Nexia の設計ファイルからコピーしてくることもでき

ます。コピーしたオブジェクトを daVinci のサーフェスに配置する場合は、コンポーネントのオプションや

Data Attributes( データ属性 ) を改めて設定する必要はありません。

　コントロールバーにはまた選択カーソルやテキストカーソルが用意されています。選択カーソル ( デフォルト ) は

オブジェクトを選択、配置、操作するためのものです。テキストカーソルはサーフェス上に静的なテキストオブジェ

クトを配置するためのものです。テキストはプロパティシートから操作できます。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

コントロールバーにあるアイコンの制御機能

 Picture　画像

　ピクチャー���������������������������������������������は制御機能を持たないイメージで、背景に使ったりロゴやアイコンなどを配置するときに使います。

Picture アイコンをクリックしてサーフェスのどこかをクリックするとこのダイアログボックスが開きます。

画像ファイルを探すときに使います。BMP、JPG、GIF、

EMF、WMF、TIF、PNG、ICO がサポートされています。

プロパティシート

→ P4

View メニュー

→ P6

クリップボードにあるイメージを配置します。

選択した画像を配置することなく削除するときに使います。

元の画像ファイルを参

照するときに使います。

画像を Audia や Nexia にある

標準メモリ上にコピーします。

Audia のみ対応する機能で、使用する画像を専用メモリ上

にコピーします。

埋め込んだ画像に識別用の名前を付けるもので、プロパ

ティシートに表示されます。リンクしている場合は元のファ

イル名とディレクトリが表示されます。　

　画像はサーフェス������で操作したりプロパ

ティシートで������������編集����������することができます。

ロジックディレイや CobraNet のバンドル番号を制御

するときに使う整数のみの機能です。

レベル調整などに使うもので小数点以下一位まで対

応します。

　この機能はサーフェス上������で操作したりプロパティシートで������������編集����������することができます。
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 Edit-Spin　エディットスピン

Create New Edit-Spin Control( エディットスピンコントロールを新規作成する )…エディットスピンコントロー

ルはキーボードによる入力かマウス操作で数値を調整できるディスプレイです。

 Button　ボタン

　モメンタリー動作のボタンでプリセットの呼び出しやコマンドストリングの送信

などといった機能をマウスで選択するために使うものです。ボタンには全画面表

示、音声の再生 / 停止、ユーザーのログイン / ログアウト、daVinci の終了といっ

た機能に関するアプリケーションをアサインすることもできます。

　この機能はサーフェス上������で操作したりプロパティシートで������������編集することができます�。

 Toggle Button　トグルボタン

　ラッチ動作のボタンでミュートや信号の極性反転などをマウスで操作するときに使うもの

です。ギャングの制御など機能に関するアプリケーションをアサインすることもできます。

　この機能はサーフェス上������で操作したりプロパティシートで������������編集することができます�。

 Fader　フェーダー

　単一の信号レベルをマウスで調整するためのものです。この機能はサーフェス上���で操作

したりプロパティシートで������������編集����������することができます。

 Meter　メーター

　単一の信号レベルを表示するものです。この機能はサーフェス上������で操作したりプロパティシート

で������������編集����������することができます。

 LED　インジケーター

　ミュート、極性反転、信号の有無など機能に関するステータスを表示するために使います。こ

の機能はサーフェス上������で操作したりプロパティシートで������������編集����������することができます。

 Grid　グリッド

　ミキサーやルーターなどのコンポーネントで入力と出力のアサイン

をマウスで設定するための制御画面です。この機能はサーフェス上

で操作したりプロパティシートで�����������������編集���������������することができます。�����右クリック

して「Edit Text」を選択すると入力 / 出力を識別するためのカスタ

ムラベルに文字を入力することができます (8 文字まで )。

プロパティシート

→ P4

ロジックディレイや CobraNet のバンドル番号を

制御するときに使う整数のみの機能です。

レベル調整時に使うもので小数点以下一位まで

対応します。

　この機能はサーフェス上������で操作したりプロパティ

シートで������������編集����������することができます。
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Layout メニュー

→ P11

レイアウトバー

→ P20

プロパティシート

→ P4

コントロールバー

→ P16

 Graph　グラフ

　イコライザー、フィルター、クロスオー

バーなどをマウスで調整するための制御

画面です。

　この機能はサーフェス上������で操作したりプ

ロパティシートで������������編集����������することができます。

 Paging　コントロールページ

　サーフェスにある複数のコントロールページをマウスで切り替えるときに使います。この機

能はサーフェス上������で操作したりプロパティシートで������������編集����������することができます。

 Dialer Control������������　ダイヤラーコントロール
　テレフォンインターフェースや VoIP の操作に使います。

　このアイコンをクリックしてからサーフェス上の配置したい場所をク

リックすると、左図の Create New Dialer Control ダイアログボックスが

表示されます。このダイアログボックスにあるプルダウンメニューで、

Telephone Interface Dialer ( テレフォンインターフェース用 ) または VoIP 

Console(VoIP 用 ) のどちらかを選んでください。選択したらプルダウン

メニューの下にある表示オプションから、使用する機能にチェックを付け

てください。

　サーフェスに配置すると操作部はすべてグループ化されていますが、

レイアウトバーまたは Layout メニューから編集することができます。

 Telephone Interface Dialer��������������������　テレフォンインターフェース・ダイヤラー
テレフォンインターフェースを操作するためのもので

す。サーフェス上で操作したりプロパティシートで編集

することができます。オンラインのとき、ダイヤルパッ

ドを右クリックして Edit Text を選択すれば、識別用に

表示させるテキストを入力することができます。

VoIP Console　VoIP コンソール
　このオブジェクトは 2 つの方法でサーフェス上に配

置することができます。1 つ目はオブジェクトツール

バーの I/O メニューから配置する方法で、この場合は

VoIP ラインを ( ライン 1、ライン 2、ライン 1 と 2) から

選択することができます。2 つ目の方法は、コントロー

ルバーの Dialer Control アイコンを配置することです。

この場合はライン 1 用のオブジェクトとして配置される

ので、ライン 2 用として使う場合は、プロパティシート

でラインを切り替えてください。

　このオブジェクトはサーフェス上で操作したりプロパ

ティシートで編集することができます。オンラインのと

き、ダイヤルパッドを右クリックして Edit Text を選択す

れば、識別用に表示させるテキストを入力することが

できます。

オブジェクトツールバー

→ P16
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 Hotspot　ホットスポット

　サーフェス上に多角形を描くための機能で、アプリケーションやコントロールページ

操作などの機能を割り当てることもできます。ホットスポットを描くためには左クリック

してドラッグします。この操作で最初の編集ポイントから線が引けます。線を描き終え

たい場所でマウスのボタンを放してください。編集ポイントや線を追加するときは左ク

リックします。ホットスポットの形状は右クリックするか最初の編集ポイントまでマウス

を戻して左クリックすると完成します。ホットスポットは Layout メニューやプロパティ

シートで編集することができます。ホットスポットは見えるものとして配置することも、

見えないものとして画像の上に配置することもできます。

Layout Bar　レイアウトバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　レイアウトバーには Layout メニューと同じ Test Mode( テストモード )、Property Sheet( プロパティシート )、

Edit Gang Groups( ギャンググループの編集 )、Layers Sheet( レイヤーシート )、Grouping( グループ化 )、

Packing( パック )、Aligning( 整列 )、Centering( 中揃え )、Spacing( 間隔調整 )、Sizing( サイズ変更 )、

Order( 並び順 )、Hotspot( ホットスポット )、Page( コントロールページ ) の各機能が集まっています。

　Toggle Ruler( ルーラー ON/OFF)、Zoom( ズーム )� は View メニューのものと同じです。Toggle Grid( グリッ

ド ON/OFF)���������������������������   は��������������������������  サーフェス上のグリッドを表示 / 非表示に�������するものです�。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

Fromat Bar　フォーマットバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　 フ ォ ー マ ッ ト バ ー に は  Font( フ ォ ン ト )、  Font Size( フ ォ ン ト サ イ ズ )、  

Bold( ボールド )、  Italic( イタリック ) といったテキストの形式に作用する機能があります。  Left( 左寄せ )、

 Center( 中揃え )、  Right( 右寄せ ) はテキストの行揃えに関する機能です。  BackColor( 背景色 ) は

サーフェスや選択したオブジェクトに作用します。  TextColor( 文字色 ) はテキストに影響します。  Fore-

Color( 前方色 ) はオブジェクトの下と右の境界線に作用します。  HiliteColor( ハイライト色 ) はオブジェクトの

上と左の境界線に作用します。  PenWidth( ペンの太さ ) はオブジェクトの境界線に作用します。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

Network Bar　ネットワークバー

　アイコンにマウスを置くとそれぞれの名称が表示されます。

　ネットワークバーには  Connect To Network( ネットワークへの接続 )、  Disconnect From Net-

work( ネットワークの切断 )、  Connect To System( システムへの接続 )、  Disconnect From Sys-

tem( システムの切断 )、  Sync Data( データ状態の同期 ) といった File メニューと同じ機能があります。

　  Send Configuration( コンフィギュレーションの送信 ) は daVinci の制御ファイルデータを選択した Audia

や Nexia に送信するものです。

　ツールバーは View メニューで開いたり閉じたりカスタマイズすることができ、任意の場所に配置できます。

プロパティシート

→ P4

Layout ����メニュー

→ P11

View ����メニュー

→ P6
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Status Bar　ステータスバー

　ステータスバーはメイン画面の一番下に配置されシステムの情報を表示します。システムのステータスが左端

に表示されます。システムやネットワークとの接続に関するステータスは中央よりに表示されます。

　この中には LPS( 権限の低いセッション ) や HPS( 権限の高いセッション ) という表示があります。複数のユーザー

が接続している場合、最初にオンラインにしたユーザーに HPS が認められます。HPS が認められたユーザーだ

けがアドミニストレータとしてアクセスできます。ステータスバーの右にはサーフェスの情報が表示されていて、そ

のコントロールページにあるオブジェクトの数、選択されているオブジェクトの数、レイヤーのステータス、オブジェ

クトの位置とサイズを見ることができます。

キーボードショートカット

ファイル管理に関するショートカット

	 Ctrl + N…����新規作成

	 Ctrl + O…����������既存のファイルを開く

	 Ctrl + S…��������データを保存する

	 Ctrl + Tab ������������   �������または���������   ������� Ctrl + F6…�����次のデータ

	 Ctrl + Shift + Tab �������������������     �������または ����������������    �������Ctrl + Shift + F6…�����前のデータ

	 Ctrl + F4…������書類を閉じる

	 Alt + F4…�������������アプリケーションを終了する

ビューモードに関するショートカット

	 Ctrl + W…����ログイン

	 Ctrl + Q…�����ログアウト

	 Ctrl + E…������   � ���������� ラン ( テスト ) モードの ON/OFF

	 Ctrl + F9…����������������� フルスクリーンモードの ON/OFF

	 Alt + F9…����������������� フルウインドウモードの ON/OFF

切り取り / コピー / 貼り付けに関するショートカット

	 Ctrl + C…������������オブジェクトをコピーする

	 Ctrl + V…������������オブジェクトを貼り付ける

	 Ctrl + D…�����������オブジェクトを複製する

	 Ctrl + X…�������������������������  � �オブジェクトを切り取る ( クリップボードにコピーを置く)

	 Del …������������������������   �オブジェクトの削除 ( クリップボードにコピーしない )

	 Alt + ��������������������������������   � ����ドラッグ����������������������������   � ����…���������������������������   � ����選択したオブジェクトの複製を ( サーフェスやライブラリに ) ドラッグ

レイアウトに関するショートカット

	 Ctrl + F…������������オブジェクトを前面に移動

	 Ctrl + B…������������オブジェクトを背面に移動

	 Ctrl + A…�������������すべてのオブジェクトを選択

	 Ctrl + G…������������������選択したオブジェクトをグループ化する

	 Ctrl + U…���������グループを解除する

	 Ctrl + R…���������再度グループ化する

	 Ctrl + J…����������次のページへ移動する

	 Ctrl + H…����������前のページへ移動する

元に戻す / やり直す � �������������/ �������������印刷に関するショートカット

	 Ctrl + Z…����元に戻す

	 Ctrl + Y …����やり直す

	 Ctrl + P…��印刷
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ツールに関するショートカット

	 Ctrl + L…��������プロパティシート

	 Ctrl + I…���������オブジェクトシート

	 Ctrl + M…����������ページ選択ダイアログ

	 F2…������������������ オブジェクトツールバーの ON/OFF

	 Shift + F2…����������������� レイアウトツールバーの ON/OFF

	 Alt + F2…������������������ コントロールツールバーの ON/OFF

	��������������������    �������レイアウト内で �������������  �������Alt + ��������������ドラッグ…ターゲットをズーム

	 F1…���ヘルプ

Processing Library

	 Shift + 1~0 …������������������� カスタムプロセシングライブラリ ����1~10
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サーフェスをデザインする

オブジェクトの配置

　daVinci を起動すると以前の作業で使用したファイルが自動的に開くので、不要なものは閉じてください。

　��������  � ����������������������������   New( 新規作成 ) を選択すると制御するシステムが Audia なのか Nexia

なのかを選択する画面が表示されます。以前に作成して保存したファイルを

呼び出すときは Open( 開く)  を選択してください。

NOTE　ファイルの拡張子は、Audia 用データが .dva、Nexia 用デー

タが .dvn です。

　サーフェスにコントロールオブジェクトを配置します。方法は 3 つあります。

①コントロールバーから個々の制御機能を配置します。各制御機能はプロパティシートの Data Attributes( デー

タ属性 ) タブでアサインします。データ属性には Instance ID( インスタンス ID)、DSP Block Type(DSP ブロッ

クの種類) 、Attributes( 属性 ) があり、特定のコンポーネントを制御する場合は Input/Output( 入力 / 出力 ) が

あります。これらの情報は Audia や Nexia の設計ファイルにあります。

②オブジェクトバーからグループ化された制御機能を配置します。オブジェクトバーの制御機能は Audia や

Nexia のシステム設計に使うコンポーネントの典型的なものです。このためデータ属性はあらかじめアサイン

されているので、インスタンス ID だけを入力すればいいことになります。インスタンス ID はプロパティシート

でアサインしますが、初期設定では 1 By 1 は無効になっています。この情報は Audia や Nexia の設計ファイ

ルにあります。

③コンパイル済みの Audia や Nexia の設計ファイルからコンポーネントオブジェクトをコピーして、daVinci のサー

フェスに直接貼り付けます。データ属性は自動的にシステム設計上のコンポーネントからコピーされるため、

daVinci のコントロールオブジェクトではプロパティシートでアサインし直す必要がありません。その結果コント

ロールオブジェクトがグループ化されているかどうかは元のコンポーネントオブジェクトによって決まります。

コントロール��バー

→ P16

プロパティシート

→ P4

オブジェクトバー

→ P16
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表示のカスタマイズ

　オブジェクトの位置はサーフェス上でドラッグすることで変更します。オブジェクトの大

きさや形状は、選択したときに表示される緑のハンドルをドラッグして変更します。位置、

サイズ、形状はプロパティシートの Display Attributes( 表示属性 ) でも変更すること

ができます。

　オブジェクト各部の色はフォーマットバーまたはプロパティシートの Data Attri-

butes( データ属性 ) で変更します。編集できる色は ON/OFF(ON のときと OFF のと

きの表示 )、Text( テキスト )、Border( 境界線 )、Back( 背景 )、Fore( 前面 )、Hi-

lite( ハイライト )、Shadow( 影 ) です。

コントロールバー

→ P16

プロパティシート

→ P4

オブジェクトバー

→ P16

　オブジェクトによってはさらに表示を編集することができます。Border 

Style & Width( 境界線の形式と太さ )、Scale Markings( 目盛り )、

Button( ボタン ) または Thum( ノブ ) Style、Orientation( 動作方向 )

などです。

Textures( 材質 )…そのオブジェクトの背景に素材のイメージを貼り

付けます。プロパティシートの Display Attributes( 表示属性 ) でイ

ンポートすることができます。この機能を選択すると Image ダイア

ログボックスが開きます。

Pictures( 画像 )…同じようにコントロールバーを���������使って������インポートす

ることができ、サーフェスの背景やロゴの配置などに使います。こ

の機能を選択すると Image ダイアログボックスが開きます。

Frames( フレーム )…コントロールバーから配置するもので、制御機

能を体系づけたりラベリングするときに使います。

Text( 静的制御 )…オブジェクトバーかコントロールバーから配置しま

す。テキストは静的制御で制御機能を体系づけたりラベルを貼った

り、あるいは背景や他の制御機能に使います。

　画像、フレーム、テキストは関連する制御機能とグループ化すること

ができるので、1 つのオブジェクトとして選択したり配置することができ

ます。サーフェスの表示そのものは上記と同様の方法で編集することが

できます。

コントロールページを追加する

　コントロールページ�������������������������とは�����������������������サーフェスを複数の部分に分けるものです。コント

ロールページはオブジェクトの種類、システムの部分などさまざまな基準で分

けることができます。コントロールページは Layout メニューまたはレイアウト

バーから追加することができます。

　新しいページを追加したら、コントロールバーから各コントロールページに

Page 制御機能を追加することになります。Page 制御機能をコントロールペー

ジ上に配置すると Page List ダイアログボックスが現れ、そのサーフェスにあ

る他のコントロールページへ移動するための誘導機能をアサインすることがで

きます。

　Page 制御機能は他のコントロールページと同じようにそのコントロールペー

ジ自体にアサインすることができます。この種類のアサインは一連のボタンを

表示して選択中のコントロールページを表示するときに使います。

　ホットスポットを Page 制御に使うこともできます。コントロールページへのアクセスをパスワードで制限する場合

はプロパティシートの Data Attributes( データ属性 ) にある User Access Level でアクセスできるユーザーのレベル

を指定します。表示された Page コントロールも編集されます。

フォーマットバー

→ P20

Image
ダイアログボックス

→ P17

ホットスポット

→ P20
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アプリケーションの制御

　オブジェクトによっては特定のアプリケーション機能を持たせることができます。この機能はプロパティシートの

Data Attributes( データ属性 ) の DSP Block Type の下に表示されます。

　ボタンとホットスポットには下記のアプリケーション機能をアサインすることができます。

全画面表示またはサーフェスの最小表示が可能です。

NOTE　自動的に全画面表示にするには Tools メ

ニューの Options ダイアログボックスから General タ

ブを選択してください。

プロパティシート

→ P4

Options
ダイアログボックス

→ P9

Layout ����メニュー

→ P11

レイアウト��バー

→ P20制御されているシステムで音声信号をミュートまたはミュート

解除する機能です。

ログイン、ログアウト用の制御機能をサーフェスに配置します。

非表示のポップアップコントロールを表示します。

トグルボタンには共通のグループをギャングしたりギャングを

解除する機能��������������を割り当てることもできます�。

ポップアップコントロールを追加する

　 　サーフェスを構成するためにコントロールページを追加すること

に加え、そのページで特定のコントロールの表示 / 非表示を切り

替えることができるポップアップも使用可能です。作用させるコン

トロールを指定したり、ポップアップボタンを割り当てる作業はプ

ロパティシートで行います。

　まず作用させるコントロールを選び、プロパティシートの Data 

Attributes にある Enable Popup フィールドで Yes を選択しま

す。各コントロールに専用のクローズ ( 非表示 ) ボタンが必要なと

きは、Show Close Button フィールドも Yes にします。

　次にボタンまたはホットスポットを配置します。プロパティシー

トの Data Attributes タブにある DSP Block Type( 用途 ) を

Application に、Service( ポップアップを開く)  フィールドを

Open Popups に設定してください。

　ポップアップボタンはパスワードプロテクトすることができます。

　ポップアップボタンの一例は、大規模なミキシングを行う際に複

数チャンネルを制御することです。いくつかのチャンネルそれぞれ

に操作部を持たせる代わりに、各チャンネルの操作部を専用のポッ

プアップボタンに割り当てます。各チャンネルの操作部を重ねてお

くことができるので、同時に 1 チャンネル分のみ表示されることに

なります。この 1 チャンネル分の操作部の隣にポップアップボタン
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を置き、アクセスできるチャンネルを選択できるようにしておきま

す。

　Popups の項に表示されている「...」をクリックすると、ポップアッ

プに対応するコントロールオブジェクトのリストが表示されます。

ポップアップボタンに対応させるコントロールを選んでください。

　コントロールを 1 つも選択せずにポップアップボタンを作ること

で、そのページにあるすべての使用可能なコントロールを閉じる

( 非表示にする ) ボタンを作ることができます。

サーフェスをテストする

　デザイン中に Layout メニューまたはレイアウトバーからテストモードに入ることができます。テストモードは一時

的にすべての編集機能を無効にして、プロパティシートとコントロールライブラリが開いている場合は閉じ、制御機

能をオフラインでテストして動作を確認するためのものです。Tools メニューの Options ダイアログボックスにある

General タブで Always use full screen in run mode にチェックが付いているとき、テストモードにすると常に全画面

表示になります。

NOTE　テストモードのまま全画面表示を解除するには Shift+F9 キーを押します。

　テストモードに入るとき作成したファイルを保存するためのプロンプトが表示されます。

プロパティシート

→ P4

Options
ダイアログボックス

→ P9

Layout ����メニュー

→ P11

レイアウト��バー

→ P20
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ネットワークについて

　10/100Base-T 対応のネットワークカードがインストールされているパソコンをお使いください。Audia あるいは

Nexia の Ethernet ポートに直接接続するときは CAT5 のクロスケーブルをお使いください。複数台の Audia や

Nexia があるネットワーク ( システム ) に接続する場合は CAT5 のストレートケーブルと Ethernet スイッチングハブ

を使って接続します。������������������������������������������ ���管理機能のある����������������������������������� ���スイッチングハブ��������������������������� ���の�������������������������� ���場合、10Base-T ������������������で�����������������の接続にアサインするときはご注意く

ださい。

　Ethernet ではスイッチングハブとAudia あるいはNexiaを接続するケーブル長が100m までに制限されています。

しかしながら光ファイバーケーブルを使うと距離の制限は 2km まで延長されます。光ファイバーケーブルと対応す

るポートを持ったスイッチングハブを使用するか、あるいはメディアコンバーターで光ファイバーと標準的な RJ45

を変換することもできます。

　パソコンには IP アドレスを設定してください。ほとんどのパソコンでは TCP/IP は自動的に設定されますが、Au-

dia や Nexia ではマニュアルでアサインしなければなりません。Audia または Nexia のシステム設計では、各ユニッ

トは独自の IP アドレス ( たとえば 192.168.1.101 など ) をアサインしなければなりません。この情報はシステム設

計ファイルでわかります。パソコンには同じネットワークで、しかし独自の IP アドレスを割り当ててください。

　�����������������������������������������������������    ほとんどの������������������������������������������������    システムは Audia または Nexia1 台����������������������������で対応できます���������������������。こうしたシステムの場合は入力と出力の数、

DSP プロセシング量は標準的なコンフィギュレーションを超えないようにしてください。1 台しか使用しない場合は

ネットワークも簡潔です。Ethernet の接続はパソコンと Audia あるいは Nexia の間だけになり、CAT5 クロスケー

ブルで接続するだけです。クロスケーブルは Audia、Nexia に付属しています。

NOTE　Audia のシステムにはよく似ていて異なるネットワーク接続、CobraNet が装備されています。

Nexia には別に NexLink という接続が用意されていますが、こちらは CAT5 のストレートケーブルでのみ

接続します。接続の際はご注意ください。

サーフェスにアクセスする

　パソコンで通信の準備が整ったら File メニューまたはネットワークバーで Connect To Network を使います。こ

の作業で System Connect ウインドウが開き、System List から該当するシステムを選択することができます。

サーフェスを送信する
プロパティシート

→ P4

Options ダイアロ
グボックス

→ P9

Layout メニュー

→ P11

レイアウトバー

→ P20

すでにシステムに送信されている daVinci ファイ

ルを探します。このためには User Accounts ダイ

アログボックスで設定したユーザー名とパスワー

ドが必要です。

そのとき開いていてアクティブになってい

るサーフェスをシステムに保存します。

daVinci のユーザー

アカウントをシステム

に送信します。

シ ス テ ム に 既 存 の

daVinci ファイルを

削除します。

NOTE　Send Control Surface、Update User Accounts、Clear Control Surface にはアドミニストレー

タのパスワードが必要です。アドミニストレータ・パスワードは Audia あるいは Nexia の設計ファイルで

Designer レベルか Technician レベルのパスワードであり、daVinci ファイルのパスワードではありません。

またアドミニストレータは HPS( 権限の高いセッション、つまり最初に接続したユーザー ) でログインしてい

なければなりません。HPS の場合はステータスバーに表示されます。

File ����メニュー

→ P5

ネットワーク��バー

→ P20

User Acount
ダイアログボックス

→ P9

HPS

→ P20
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サーフェスの準備

　一般的には専用のパソコンが複数台ネットワークに接続され、daVinci ソフトウェアが起動され、ユーザーはログ

イン / ログアウトによってサーフェスにアクセスできるようになります。このためにはまずサーフェスをシステムに送

信しなければなりません。

　サーフェスの送信はアドミニストレータが行います。アドミニストレータはエンドユーザーのためにアプリケーショ

ン制御機能をサーフェス上に用意します。アプリケーション制御機能にはサーフェスの設計、ユーザーアクセスレ

ベルによるアサイン制限が含まれています。アドミニストレータはこうした制御機能を使ってサーフェスをユーザー

モード ( 全画面表示など ) にすることもできます。アドミニストレータがログアウトしてもユーザーがログイン / ログ

アウトできるようにパソコンは動作したままにしておきます。

NOTE　ログイン / ログアウトはサーフェス上のアプリケーション制御機能に割り当てることができ、エンド

ユーザーからのアクセスを可能にするものです。サーフェスを開いたりテストするとき自動的に全画面表示

するよう設定する場合は、Tools メニューの Options ダイアログボックスにある General タブで設定してく

ださい。

Options
ダイアログボックス

→ P9
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サーフェスを使用する

　一般的には専用のパソコンがネットワークに接続され、daVinci ソフトウェアが起動され、ユーザーはログイン

/ ログアウトによってサーフェスにアクセスできるようになります。専用のログイン / ログアウト制御もサーフェス上に

作ることができます。ログインには User Accounts ダイアログボックスで設定したユーザー名とパスワードが必要

です。

　サーフェスが使えない (daVinci やパソコンが起動していない ) 場合はユーザーは Connect To Network と

Open( 開く)  を機能させなければなりません。

NOTE　この方法はアドミニストレータによって設定されたユーザーモードでバイパスすることができます。

User Acount
ダイアログボックス

→ P9


